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IRWIN ArcGIS Online GeoPlatform Services  

The Integrated Reporting of Wildland-Fire Information (IRWIN) Production data is replicated every 60 seconds to the 

ArcGIS Online GeoPlatform organization so that read-only views can be provided for consumers.  This replicated view is 

called the hosted datastore. The “IRWIN Data” group is a set of Feature Layer views based on the replicated IRWIN layers. 

These feature layers provide a near real-time feed of all valid IRWIN data.  All incidents that have been shared through 

the integration service since May 20, 2014 are available through this service.  

The incident data provides the location of existing fires, size, conditions, and several other attributes that help classify 

fires. The IRWIN Data service allows users to create a web map, share it with their organization, or pull it into ArcMap or 

ArcGIS Pro for more in-depth analysis.  

Accessing the GeoPlatform “IRWIN Data” Service  

Below are the steps to access the layer:  

You must complete these steps to access the IRWIN Observer application: 

 

● Create a Login.gov account (one time only) 

● Request membership in ArcGIS Online group(s) (one time only) 

 

Creating a Login.gov Account 

NOTE: This is a one-time task. If you already have a Login.gov account, you can skip ahead to the next section. 

 

Login.gov is a secure sign in service used by the public to sign in to participating government agencies, including 

GeoPlatform ArcGIS Online. You can use the same username and password to access any agency that partners with 

Login.gov. This streamlines your process and eliminates the need to remember multiple usernames and passwords. 

 

Navigate to https://login.gov/ and click the “Create an account” link: 

 

https://login.gov/
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Follow the instructions to create your Login.gov account.  
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Requesting Membership in ArcGIS Online Group(s) 

NOTE: This is a one-time task. If you already have the required group membership(s), you can skip ahead to the next 

section. 

 

In order to access the IRWIN Data Service, you must first be a member of an ArcGIS Online Group.  

 

Navigate to https://geoplatform.maps.arcgis.com/  and click the “Sign In” button: 

 

 
 

  

https://geoplatform.maps.arcgis.com/
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Select the option to log in using your Login.gov account: 

 

 
 

Provide your username, password, and multi-factor authentication to enter the GeoPlatform site. 

 

  



 

7 
 

Once you have returned to the GeoPlatform site, click the “Request Support” button: 
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Select the “GeoPlatform Account Permissions and Group Changes” option: 
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Select the “ArcGIS Online Group/Permission Change” option: 
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Complete the form. In the “Username” field, enter your Login.gov username. In the “Group(s)/Permission(s) 

Requested” field enter “IRWIN Data”. 

 

 
 

Click the “Send” button. 

Your request will be processed, and you will receive a confirmation email at the email address you provided in the 

previous step. The time it takes to process your request may vary. 

 

Please do not proceed to the next section until you have received confirmation of your group membership(s). 
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Understanding the “IRWIN Data” Group  

The screen below shows the Overview tab for the IRWIN Data group page.  This tab provides general information about 

the items contained in this group.  At the bottom of this screen, or by clicking on the Content tab, you will see the items 

in this group.  

 

There are 2 incident-related items in the group:  

1. IRWIN Incident Data:  This service includes all data elements in the IRWIN Incidents feature layer and all records 

that are valid (See the “Filtering of the Incidents Data” section for more information).  The definition of valid 

elements can be found at the end of this document in the “Data Elements Definitions” table. The incidents layer 

includes 2 related tables – Incident_Relationships and Incident_Resource_Summary.  

  

2. IRWIN Incident Transactions: This service provides all the transactions (adds and updates) that have been made 

on each IRWIN Incident through the Incident History Layer.  All data elements are available for reading.  
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Click on the title of the item to go to the item’s page. Key items on this page include:  

• On the bottom, under “Layers,” there is a link that will allow you to access the ArcGIS Server REST endpoint. 

Please note, you will not be able to navigate around the ArcGIS Server Rest endpoint, only view the individual 

page to which you’ve been given access.  

• On the bottom, under “Tables” there is a link that will allow you to access the 2 tables that are related to 

incidents, the Relationships and Resource Summary.  
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For more help on working with the items in a group, go to: http://doc.arcgis.com/en/arcgis-online/share-

maps/itemdetails.htm  

Downloading IRWIN Data  

From the Overview tab of the IRWIN Incident Data item, click on the “Export Data” button on the right side of the page.  

  

http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
http://doc.arcgis.com/en/arcgis-online/share-maps/item-details.htm
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You can choose to export the table in one of many formats: Shapefile, CSV, KML, Excel, FGDB, GeoJSON or Feature 

Collection. Note that large tables may not open in Excel; a CSV format is a better option in that case.  

When prompted, add a title, tag and specify a folder. The file will download to the folder specified (in your AGOL 

account).  

  

Depending on the size of the file, this could take several minutes. When complete, the export will open in your browser. If 

it doesn’t or you close the screen, you can find the export under Content > My Content.  

From the item’s Overview page, you can download the file to your computer. Click “Download”  

  

  

  

Accessing the IRWIN Data Service items in ArcMap  

To add the IRWIN  data service to ArcMap, reference the following online documentation:    

http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm  

  

• After opening ArcMap navigate to File > Sign in  

• Below the Username and Password option, select Enterprise  

http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
http://desktop.arcgis.com/en/arcmap/latest/map/working-with-arcmap/adding-data-from-arcgis-online.htm
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• Enter “geoplatform” into the open box  

• Log-in with your ArcGIS Online GeoPlatform username and password  

• Navigate to File > ArcGIS Online  

• From this dialog box, navigate to My Groups > IRWIN Data > IRWIN Incident Data  

Adding the IRWIN Data Service items to a web map  

To create a web map with the IRWIN Data services within the GeoPlatform Organization, reference the following online 

documentation:  http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm  

  

• Navigate to the Overview tab of the IRWIN Incident Data service page.  

• Click “Open in Map Viewer” in the top-right corner.  

Accessing the Service Endpoint from a custom application  

Application developers can use the REST endpoint to query the service as needed to return JSON data. To query the 

service, a token is required that is generated from ArcGIS.com using an ArcGIS account and the user’s own login 

credentials. A token is returned in JSON format that can then be supplied to the REST endpoint methods to perform the 

query.  

For example, a token can be generated by calling the ArcGIS.com token generator endpoint with your ArcGIS account 

credentials:  

https://www.arcgis.com/sharing/generatetoken?expiration=120&referer=localhost&f=json&username=<YOURUSERNA 

ME>&password=<YOURPASSWORD>  

The returned token can then be appended to subsequent requests to the IRWIN Incidents Data REST endpoint’s ‘query’ 

method along with the desired Where Clause and other parameters to return JSON data matching the query.  

For example, a query to retrieve all IRWIN Incidents with Point of Origin State as ‘California’ and returning all available 

attributes fields in JSON format is:  

https://services1.arcgis.com/Hp6G80Pky0om7QvQ/arcgis/rest/services/IRWIN_Incidents/FeatureServer/0/query?where 

=POOState='US-CA'&outFields=*&f=json&token=<YOURTOKEN  

Note that these samples are using a simple GET HTTP method with all parameters in a single URL for illustration 

purposes. In practice, developers should use a POST method and other encryption methods to avoid sending credentials 

visibly across the network.  

  

  

  

http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
http://doc.arcgis.com/en/arcgis-online/create-maps/add-layers.htm
https://www.arcgis.com/sharing/generatetoken?expiration=120&referer=localhost&f=json&username=%3cYOURUSERNAME%3e&password=%3cYOURPASSWORD
https://www.arcgis.com/sharing/generatetoken?expiration=120&referer=localhost&f=json&username=%3cYOURUSERNAME%3e&password=%3cYOURPASSWORD
https://www.arcgis.com/sharing/generatetoken?expiration=120&referer=localhost&f=json&username=%3cYOURUSERNAME%3e&password=%3cYOURPASSWORD
https://www.arcgis.com/sharing/generatetoken?expiration=120&referer=localhost&f=json&username=%3cYOURUSERNAME%3e&password=%3cYOURPASSWORD
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It is important to note that the Irwin ID is in a slightly different format than what is in the Production Data endpoint:  

GUIDs in the IRWIN API (ArcGIS Server):   

• Capitalized   

• Wrapped in curly braces   

  

GUIDs in the IRWIN Data services (ArcGIS Online):   

• Lowercase   

• No curly braces   

  

For more information and examples, you can also reference https://developers.arcgis.com/rest/services-

reference/getstarted-with-the-services-directory.htm for assistance in working with the ArcGIS REST Services.    

  

Additional guidance on leveraging ArcGIS REST Services for custom developed applications can be found at the following 

links:   

  

Generating Tokens https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm  

  

Querying layers https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm  

Filtering of the Incidents Data  

The IRWIN Incident Data service is identical to the IRWIN Production as of April 21, 2020. Prior to this date, the service 

returned only the valid incidents that have been exchanged through the IRWIN integration.  Behind the scenes, the 

following query was used to extract the incidents from the IRWIN Production API.    

IsValid = 'true'   

Data Element Definitions  

When using the service, it is important to understand the definitions of the data that are being populated by the external 

systems contributing to the incident records.  The table below shows each the name and a short description for data 

element available in the service.   

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  FireDiscoveryDateTime  Numeric(13,0)  1483228800000  The date and time a fire was reported 

as discovered or confirmed to exist.  

https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/services-reference/get-started-with-the-services-directory.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/users-groups-and-items/generate-token.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
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May also be the start date for reporting 

purposes.  

Incident  IncidentName  String(50)  Red Hill Fire  The name assigned to an incident.  

Incident  IncidentTypeCategory  String(2)  If Kind = FI then 

Cat = WF, ST, VF, 

etc...  

The Event Category is a sub-group of 

the Event Kind code and description. 

The Event Category further breaks 

down the Event Kind into more specific 

event categories.  

Incident  IncidentTypeKind  String(2)  FI  A general, high-level code and 

description of the types of incidents 

and planned events to which the 

interagency wildland fire community 

responds.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  isFirecodeRequested  smallint  0, 1 (0 is false, 1 

is true)  
When a source application sends the 
SubmitIncident or Update Incident 
request to IRWIN, FirecodeRequested is 
a Boolean value indicating whether a  
Fire Code needs to be generated from 

Fire Code for the incident.  The 

combination of FirecodeRequested and 

the value in the FireCode column 

determines the validity of the current 

FireCode in the IRWIN incidents table - 

valid or pending (waiting for firecode)  

Incident  LocalIncidentIdentifier  String(6)  000087, 00DK1E  A number or code that uniquely 

identifies an incident for a particular 

local fire management organization 

within a particular calendar year.  

Incident  POOProtectingUnit  String(6)  SSUUUU, IDBOF  NWCG Unit responsible for providing 
direct incident management and 
services to an incident pursuant to its 
jurisdictional responsibility or as 
specified by law, contract or agreement.                                                     
Definition Extension:  
- Protection can be re-assigned 
by agreement.  
- The nature and extent of the 

incident determines protection (for 

example Wildfire vs. All Hazard.)  
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Incident  Shape  Shape     Geographic representation of POO in 
NAD83 datum.  
The latitude location is the point of 

origin specified in decimal degrees. 

Point of origin is the location where a 

competent ignition source came into 

contact with the material first ignited 

and sustained combustion occurred.  

The longitude location is the point of 

origin specified in decimal degrees. 

Point of origin is the location where a 

competent ignition source came into 

contact with the material first ignited 

and sustained combustion occurred.  

Incident  FireCause  String(15)  Natural, Human,  
Unknown  

Broad classification of the reason the 

fire occurred identified as human, 

natural or unknown.   

Incident  InitialLatitude  Numeric (38,8)  DD.DDDDD  The latitude location of the initial 

reported point of origin specified in 

decimal degrees.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  InitialLongitude  Numeric (38,8)  -DDD.DDDDD  The longitude location of the initial 

reported point of origin specified in 

decimal degrees.  

Incident  DiscoveryAcres  Numeric (38,8)  9(9).9  An estimate of acres burning upon the 
discovery of the fire. More specifically 
when the fire is first reported by the  
first person that calls in the fire.  The 

estimate should include number of 

acres within the current perimeter of a 

specific, individual incident, including 

unburned and unburnable islands.  

Incident  DispatchCenterID  String(6)  SSUUUU, IDBDC  A unique identifier for a dispatch center 

responsible for supporting the incident.  

Incident  ABCDMisc  String(4)     A FireCode used by USDA FS to track 

and compile cost information for 

emergency initial attack fire 

suppression expenditures for A, B, C & 

D size class fires on FS lands.  

Incident  AdditionalFuelModel  String(30)  Timber (Grass 

and Understory)  
The fuel model which best represents 

an additional carrier of the fire.  
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Incident  ADSPermissionState  String(100)  DEFAULT,  
ICS209,  
CERTIFIED  

Indicates the permission hierarchy that 

is currently being applied when a 

system utilizes the UpdateIncident 

operation.  

Incident  CalculatedAcres  numeric(38,8)  9(9).9  A measure of acres calculated (i.e., 

infrared) from a geospatial perimeter 

of a fire.  More specifically, the number 

of acres within the current perimeter 

of a specific, individual incident, 

including unburned and unburnable 

islands.  The minimum size must be 

0.1.  

Incident  ConflictParentIrwinID  GUID     The IrwinID of an IRWIN record that 
conflicted with this record based on the 
conflict detection algorithm and  
set by the CAD.  The  
ConflictParentIrwinID is the 

authoritative record of this incident.   

Incident  ContainmentDateTime  Numeric(13,0)  1483228800000  The date and time a wildfire was 

declared contained.   

Incident  ControlDateTime  Numeric(13,0)  1483228800000  The date and time a wildfire was 

declared under control.  

Incident  CreatedBySystem  String(255)  wildcad  ArcGIS Server Username of system that 

created the IRWIN Incident record.  

Incident  CreatedOnDateTime  Numeric(13,0)  1483228800000  Date/time that the IRWIN Incident 

record was created.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  CriticalResourceNeeds  String(255)  This is free-form 

text  
Text field that describes the current 

resource needs as assessed by the 

management team. The comments in 

this field can be changing rapidly and 

are not always accurate.  This data 

should not be used for public reporting 

of resource needs.  

Incident  DailyAcres  numeric(38,8)  9(9).9  A measure of acres reported for a fire.  

More specifically, the number of acres 

within the current perimeter of a 

specific, individual incident, including 

unburned and unburnable islands.  The 

minimum size must be 0.1.  

Incident  EstimatedContainment 

Date  
Numeric(13,0)  1483228800000  The estimated date a wildfire will be 

contained.  
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Incident  EstimatedCostToDate  numeric(38,8)     Estimated total incident costs to date 
for the entire incident based on 
currently available information.  Costs  
include estimates for all costs for the 

response including management and 

support activities.  

Incident  Fatalities  integer     The total number of deaths of 

personnel assigned to an incident.   

Incident  FinalAcres  numeric(38,8)  9(9).9  The measure of acres within the final 

perimeter of a fire.  More specifically, 

the number of acres within the final fire 

perimeter of a specific, individual 

incident, including unburned and 

unburnable islands.  

Incident  FinalFireReportApprov 

edBy  
String(100)  John D.  

Supervisor  
The name of the person that approved 

the final fire report for the incident.  

Incident  FinalFireReportApprov 

edByTitle  
String(100)  Fire  

Management  
Officer  

The title of the person that approved 

the final fire report for the incident.  

Incident  FinalFireReportApprov 

edByUnit  
String(6)  SSUUUU, IDBOF  NWCG Unit ID associated with the 

individual who approved the final 

report for the incident.  

Incident  FinalFireReportApprov 

edDate  
Numeric(13,0)  1483228800000  The date that the final fire report was 

approved for the incident.  

Incident  FinalFireReportNarrativ 

e  
String(3999)     A summary of the comments in 

narrative form as entered on the final 

fire report to describe important 

aspects of the incident.  

Incident  FinalStrategyAttainedD 

ateTime  
Numeric(13,0)  1483228800000  The date/time the final fire strategy 

was accomplished on the incident.  

Incident  FireBehaviorDescriptio 

n  
String(3999)     A description of the observed fire 

behavior for the current ICS-209 

reporting period.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  FireBehaviorGeneral  String(20)  Extreme  A general category describing the 

manner in which the fire is currently 

reacting to the influences of fuel, 

weather, and topography.   

Incident  FireBehaviorGeneral1  String(50)  Crowning  A more specific category further 

describing the general fire behavior 

(manner in which the fire is currently 

reacting to the influences of fuel, 

weather, and topography).   
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Incident  FireBehaviorGeneral2  String(50)  Running  A more specific category further 

describing the general fire behavior 

(manner in which the fire is currently 

reacting to the influences of fuel, 

weather, and topography).   

Incident  FireBehaviorGeneral3  String(50)  Long-range 

Spotting  
A more specific category further 

describing the general fire behavior 

(manner in which the fire is currently 

reacting to the influences of fuel, 

weather, and topography).   

Incident  FireCauseGeneral  String(100)  Camping  Agency or circumstance which started a 

fire or set the stage for its occurrence; 

source of a fire's ignition. For statistical 

purposes, fire causes are further 

broken into specific causes.   

Incident  FireCauseSpecific  String(200)  Cooking  A further categorization of each 

General Fire Cause to indicate more 

specifically the agency or circumstance 

which started a fire or set the stage for 

its occurrence; source of a fire's 

ignition.   

Incident  FireCode  String(4)  K14B  A code used within the interagency 

wildland fire community to track and 

compile cost information for 

emergency fire suppression 

expenditures for the incident.   

Incident  FireDepartmentID  String(5)  WC701  The U.S. Fire Administration (USFA) has 

created a national database of Fire 

Departments.  Most Fire Departments 

do not have an NWCG Unit ID and so it 

is the intent of the IRWIN team to 

create a new field that includes this 

data element to assist the National 

Association of State Foresters (NASF) 

with data collection.  

Incident  FireGrowthCessationDa 

teTime  
Numeric(13,0)  1483228800000  The date/time that the fire perimeter 

stopped growing in size.   

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  FireIgnitionDateTime  Numeric(13,0)  1483228800000  The actual date/time that the fire 

began ignition. This date may be 

different from the fire discovery date.  
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Incident  FireMgmtComplexity  string(25)  Type 1 Incident,  
Type 2 Incident,  
Type 3 Incident,  
Type 4, etc…  

The highest management level utilized 

to manage a wildland fire event.   

Incident  FireOutDateTime  Numeric(13,0)  1483228800000  The date and time when a fire is 

declared out.   

Incident  FireStrategyConfinePer 

cent  
integer  25  Indicates the percentage of the incident 

area where the fire suppression 

strategy of "Confine" is being 

implemented.  

Incident  FireStrategyFullSuppPe 

rcent  
integer  25  Indicates the percentage of the incident 

area where the fire suppression 
strategy of "Full  
Suppression" is being implemented.  

Incident  FireStrategyMonitorPer 

cent  
integer  25  Indicates the percentage of the incident 

area where the fire suppression 

strategy of "Monitor" is being 

implemented.  

Incident  FireStrategyPointZoneP 

ercent  
integer  25  Indicates the percentage of the incident 

area where the fire suppression 

strategy of "Point Zone Protection" is 

being implemented.  

Incident  FiscallyResponsibleUnit  String(6)  SSUUUU, IDBOF  NWCG Unit who has fiscal responsibility 

for the incident.  

Incident  FSJobCode  String(2)     A code use to indicate the Forest 

Service job accounting code for the 

incident.  This is specific to the Forest 

Service.  Usually displayed as 2 char 

prefix on FireCode.  

Incident  FSOverrideCode  String(4)  1502  A code used to indicate the Forest 
Service override code for the incident.  
This is specific to the Forest Service.   
Usually displayed as a 4 char suffix on 

FireCode.  For example, if the FS is 

assisting DOI, an override of 1502 will 

be used.  

Incident  GACC  String(50)  NRCC  A code that identifies one of the 
wildland fire geographic area 
coordination centers.  
A geographic area coordination center 

is a facility that is used for the 

coordination of agency or jurisdictional 

resources in support of one or more 

incidents within a geographic 

coordination area.  
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IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  HasFatalities  smallint  0, 1 (0 is false, 1 

is true)  
Indicates whether there were fatalities 

related to the incident.  

Incident  HasInjuries  integer  0, 1 (0 is false, 1 

is true)  
Indicates whether there were injuries 

related to the incident.  

Incident  ICS209Remarks  String(3999)     Additional information pertinent to the 

incident management.  

Incident  ICS209ReportDateTime  Numeric(13,0)  1483228800000  The date and time of the latest 

approved ICS-209 report.  

Incident  ICS209ReportForTimeP 

eriodFrom  
DATE/TIME     The date and time of the beginning of 

the time period for the current ICS-209 

submission.  

Incident  ICS209ReportForTimeP 

eriodTo  
DATE/TIME     The date and time of the end of the 

time period for the current ICS-209 

submission.    

Incident  ICS209ReportStatus  string(1)  I (Initial), U  
(Update),  
F(Final)  

The version of the ICS-209 report 
(initial, update, or final). There should 
never be more than one initial report, 
but there can be numerous updates,  
and even multiple finals (as determined 

by business rules).  

Incident  IncidentCommanderNa 

me  
string(255)  John Doe  The first (optional) and last name of the 

incident commander currently assigned 

to the incident.  

Incident  IncidentManagementO 

rganization  
string(255)  Type 1 Team,  

Type 2 Team,  
Type 3 IC, Area  
Command,  
NIMO, etc…  

The incident management organization 
for the incident, which may be a Type 
1, 2, or 3 Incident  
Management Team (IMT), a Unified 
Command, a Unified Command with 
an IMT, National Incident  
Management Organization (NIMO),  
etc.  This field is null if no team is 

assigned.  

Incident  IncidentShortDescriptio 

n  
String(80)     General descriptive location of the 

incident such as the number of miles 

from an identifiable town.   

Incident  InFuelTreatment  smallint  0, 1 (0 is false, 1 

is true)  
Indicates whether the incident's point 
of origin lat/long intersects with an  
existing fuel treatment area. PLANNED 

TREATMENTS  

Incident  InitialFireStrategy  String(50)  Full Suppression,  
Point Zone  
Protection,  
Confine,  
Monitor  

The fire strategy initially used on a 

wildland fire; the general plan or 

direction utilized until it succeeds or 

changes.   
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IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  InitialResponseAcres  Numeric (38,8)  9(9).9  An estimate of acres burning at the 

time of initial response. More 

specifically when the IC arrives and 

performs initial size up.  The minimum 

size must be 0.1.  The estimate should 

include number of acres within the 

current perimeter of a specific, 

individual incident, including unburned 

and unburnable islands.  

Incident  InitialResponseDateTim 

e  
Numeric(13,0)  1483228800000  The date/time of the initial response to 

the incident. More specifically when 

the IC arrives and performs initial size 

up.    

Incident  Injuries  integer     The total number of reportable 

occupational injuries and illnesses that 

occurred in conjunction with an 

incident.   

Incident  InNFPORS  integer  0, 1 (0 is false, 1 

is true)  
Indicates whether the incidents point 

of origin lat/long intersects with a 

COMPLETED fuels treatment.  

Incident  IrwinID  GUID  {3A74AD5CE18C-
4B239DA0- 
B5EEFF6CDACF}  

Unique identifier assigned to each 

incident record in IRWIN.  

Incident  IsFireCauseInvestigated  smallint  0, 1 (0 is false, 1 

is true)  
Indicates if an investigation is underway 

or was completed to determine the 

cause of a fire.  

Incident  IsFSAssisted  smallint  0, 1 (0 is false, 1 

is true)  
Indicates if the Forest Service provided 

assistance on an incident outside their 

jurisdiction.  

Incident  IsInitialFireStrategyMet  integer  0, 1 (0 is false, 1 

is true)  
Indicates if the initial fire strategy for 

the incident was successful.  

Incident  IsMultiJurisdictional  integer  0, 1 (0 is false, 1 

is true)  
Indicates if the incident covers multiple 

jurisdictions.  

Incident  IsQuarantined  smallint  0, 1 (0 is false, 1 

is true)  
Indicates whether an incident of type 

WF is potentially conflicting with 

another incident of type WF.   

Incident  IsReimbursable  smallint  0, 1 (0 is false, 1 

is true)  
Indicates the cost of an incident may be 

another agency’s responsibility.  

Incident  IsTrespass  smallint  0, 1 (0 is false, 1 

is true)  
Indicates if the incident is a trespass 

claim or if a bill will be pursued.  

 



 

25 
 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  IsUnifiedCommand  smallint  0, 1 (0 is false, 1 

is true)  
Indicates whether the incident is being 

managed under Unified Command.  

Unified Command is an application of 

the Incident Command System used 

when there is more than one agency 

with incident jurisdiction or when 

incidents cross political jurisdictions. 

Under Unified Command, agencies 

work together through their designated 

Incident Commanders at a single 

incident command post to establish 

common objectives and issue a single 

Incident Action Plan.  

Incident  IsValid  smallint  0, 1 (0 is false, 1 

is true)  
Indicates whether the incident is valid 

within IRWIN. Valid incidents are 

Wildfire Incident records from the 

Dispatch Center having primary 

responsibility for that fire.  Invalid 

incidents are a result of duplicates or 

invalid entries.  

Incident  ModifiedBySystem  String(255)     ArcGIS Server username of system that 

last modified the IRWIN Incident 

record.  

Incident  ModifiedOnDateTime  Numeric(13,0)  1483228800000  Date/time that the IRWIN Incident 

record was last modified.  

Incident  ModifiedOn  DATETIME    The date and time (DATETIME format) 

that the IRWIN Incident record was last 

modified.  This format is provided as a 

helper to support querying and 

filtering.  

Incident  OtherStructuresDestro 

yed  
Long integer (999,999)     The total number of structures, other 

than residences, destroyed as a result 

of a fire.   

Incident  OtherStructuresThreat 

ened  
Long integer (999,999)     The total number of structures, other 

than residences, threatened by a fire.   

Incident  PercentContained  Integer     Indicates the percent of incident area 

that is no longer active.  Reference 

definition in fire line handbook when 

developing standard.  
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Incident  PercentPerimeterToBe 

Contained  
Integer     Indicates the percent of perimeter left 

to be completed. This entry is 

appropriate for full suppression, 

point/zone protection, and confine 

fires, or any combination of these 

strategies. This entry is not used for 

wildfires managed entirely under a 

monitor strategy.  (Note: Value is not 

currently being passed by ICS-209)  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  PlannedActions  String(3999)     Short summary of the actions planned 
for the next operational period. (Note:  
Value is not currently being passed by 

ICS-209)  

Incident  POOCity  String(50)     The closest city to the incident point of 

origin.  

Incident  POOCounty  String(100)  Ada County  The County Name identifying the county 

or equivalent entity at point of origin 

designated at the time of collection.  

Incident  POODispatchCenterID  String(6)  SSUUUU, IDBDC  A unique identifier for the dispatch 

center that intersects with the incident 

point of origin.   

Incident  POOFips  String(5)  ID001  The code which uniquely identifies 

counties and county equivalents.  The 

first two digits are the FIPS State code 

and the last three are the county code 

within the state.  

Incident  POOJurisdictionalAgen 

cy  
String(50)  BLM, USFS, BIA  The agency having land and resource 

management responsibility for an 

incident as provided by federal, state or 

local law.   

Incident  POOJurisdictionalUnit  String(6)  SSUUUU  NWCG Unit Identifier to identify the 

unit with jurisdiction for the land where 

the point of origin of a fire falls.     

Incident  POOJurisdictionalUnitP 

arentUnit  
String(6)  SSUUUU, IDBOF  The unit ID for the parent entity, such as 

a BLM State Office or USFS Regional 

Office, that resides over the 

Jurisdictional Unit.  
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Incident  POOLandownerCategor 

y  
String(7)  If Kind = Federal,  

Cat = BIA, BLM,  
BOR, etc…  

More specific classification of land 

ownership within land owner kinds 

identifying the owner at the point of 

origin at the time of the incident. Owner 

in the context of this data element 

refers to the agency or entity having the 

land management responsibility at the 

point of origin.  

Incident  POOLandownerKind  String(7)  Federal, Other, 

Private  
Broad classification of land ownership at 

the point of origin.  

Incident  POOLegalDescPrincipal 

Meridian  
String(30)     The principal meridian of the legal 

description (section, township, range) of 

the incident at point of origin.  

Incident  POOLegalDescQtr  String(2)     The quarter section of the legal 

description (section, township, range) of 

the incident at point of origin.  

Incident  POOLegalDescQtrQtr  String(2)     The quarter/quarter section of the legal 

description (section, township,  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

    range) of the incident at point of origin.  

Incident  POOLegalDescRange  String(5)     The range of the legal description 

(section, township, range) of the 

incident at point of origin.  

Incident  POOLegalDescSection  Integer     The section of the legal description 

(section, township, range) of the 

incident at point of origin.  

Incident  POOLegalDescTownshi 
p  

String(5)     The township of the legal description 

(section, township, range) of the 

incident at point of origin.  

Incident  POOPredictiveServiceA 

reaID  
String(6)  NR01 - Northern 

Idaho Panhandle  
The predictive service area ID where 

the incidents point of origin is location.  

Predictive Service Areas (PSAs) are 

geographic areas of similar climate 

based on statistical correlation of 

Remote Automated Weather Stations 

(RAWS) data.  

Incident  POOProtectingAgency  String(50)  BLM, NPS, BIIA  Indicates the agency that has 

protection responsibility at the point of 

origin.  



 

28 
 

Incident  POOState  String(6)  ID  The State alpha code identifying the 

state or equivalent entity at point of 

origin.  

Incident  PredominantFuelGroup  String(100)  GR  The fuel majority fuel model type that 

best represents fire behavior in the 

incident area, grouped into one of 

seven categories.  

Incident  PredominantFuelMode 

l  
String(100)  Grass  Describes the type of fuels found within 

the majority of the incident area.    

Incident  PrimaryFuelModel  String(30)  Timber (Grass 

and Understory)  
The fuel model which best represents 

the primary carrier of the fire for the 

reporting period.  

Incident  ProjectedIncidentActivi 

ty12  
String(3999)     An estimate of the direction in which 

the incident is expected to spread, 

migrate or expand in the next 12 hours.  

Incident  ProjectedIncidentActivi 

ty24  
String(3999)     An estimate of the direction in which 

the incident is expected to spread, 

migrate or expand in the next 24 hours.  

Incident  ProjectedIncidentActivi 

ty48  
String(3999)     An estimate of the direction in which 

the incident is expected to spread, 

migrate or expand in the next 48 hours.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident  ProjectedIncidentActivi 

ty72  
String(3999)     An estimate of the direction in which 

the incident is expected to spread, 

migrate or expand in the next 72 hours.  

Incident  ProjectedIncidentActivi 

ty72Plus  
String(3999)     An estimate of the direction in which 

the incident is expected to spread, 

migrate or expand in beyond the next 

72 hours.  

Incident  ResidencesDestroyed  Long integer (999,999)     The total number of residences 

destroyed, or damaged to an extent 

requiring rebuilding, as a result of a 

fire.   

Incident  ResidencesThreatened  Long integer (999,999)     The total number of residences 

threatened by the fire.   

Incident  SecondaryFuelModel  String(30)  Timber (Grass 

and Understory)  
The fuel model which best represents 

the secondary carrier of the fire for the 

reporting period.  
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Incident  SignificantEvents  String(3999)     Observed fire behavior or significant 

incident events for the current 

reporting period.  

Incident  SummaryFuelModel  String(3999)  canyons with 
Spruce and Fir 
stringers; open  
meadows with  
grass 2-4'  

A brief summary of the type of terrain 

or any significant fuel considerations 

for the reporting period.  

Incident  TotalIncidentPersonnel  Integer     The total number of personnel 

assigned. Includes overhead, 

crewmembers, helicopter 

crewmember, engine crewmembers, 

camp crew people, etc.  

Incident  UniqueFireIdentifier  String(22)  yyyy-

SSUUUUxxxxxx, 

2007IDBOF-

000025  

Unique identifier assigned to each 

wildland fire.  yyyy = calendar year, 

SSUUUU = POO protecting unit 

identifier (5 or 6 characters), xxxxxx = 

local incident identifier (6 to 10 

characters)   

Incident  WeatherConcerns  String(3999)     A brief summary of how the current 

weather is affecting the incident and 

how the anticipated weather will affect 

the incident.  

Incident  WFDSSDecisionStatus  String(20)  Pending Decision  Indicates the state of the WFDSS 

decision and/or if a WFDSS decision 

has been approved for the incident.  

This information is helpful in resolving 

conflicts between incident records.  

Incident  INFORMUsername  String(50)  stevensj  Temporary meta data field to capture 

inform user information.  Will be 

deprecated for V6.  

 

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident_Relat 

ionship  
ChildIrwinID  GUID  {3A74AD5CE18C-

4B239DA0- 
B5EEFF6CDACF}  

The IRWINID of the child incident of 

the relationship formed between 2 

incidents.  

Incident_Relat 

ionship  
CreatedBySystem  String(255)  wildcad  Auto calculated by IRWIN upon 

SubmitRelationship.  
ArcGIS Server Username of system that 

created the IRWIN Incident 

relationship.  

Incident_Relat 

ionship  
CreatedOnDateTime  Numeric(13,0)  1511907191  Auto calculated by IRWIN upon add The 

UTC time when the Relationship was 

created in IRWIN.  
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Incident  CreatedOn  DATETIME    The date and time (DATETIME 

format) that the IRWIN Incident 

record was created.  This format is 

provided as a helper to support 

querying and filtering.  

Incident_Relat 

ionship  
IrwinIRID  GUID  {3A74AD5CE18C-

4B239DA0- 
B5EEFF6CDACF}  

The IRWINID of the relationship formed 

between 2 incidents.  

Incident_Relat 

ionship  
IsActive  integer  0, 1 (0 is false, 1 

is true)  
Represents if the relationship is active 

(true) or expired (false).  

Incident_Relat 

ionship  
ModifiedBySystem  String(255)  wildcad  Auto calculated by IRWIN upon update.  

ArcGIS Server username of system that 

updated the IRWIN Incident 

relationship.  

Incident_Relat 

ionship  
ModifiedOnDateTime  Numeric(13,0)  1483228800000  Auto calculated by IRWIN upon update.  

The UTC time when the relationship 

was modified in IRWIN.  

Incident_Relat 

ionship  
ParentIrwinID  GUID  {3A74AD5CE18C-

4B239DA0- 
B5EEFF6CDACF}  

The IrwinID of the parent incident of 

the relationship formed between 2 

incidents.  

Incident_Relat 

ionship  
RelationshipType  String((10)  Complex  Indicates the type of relationship being 

submitted to IRWIN that defines how 

two incidents are related to each other.  

Incident_Relat 

ionship  
ReportedCreatedOnDat 

eTime  
Numeric(13,0)  1483228800000  The UTC time when the relationship 

was created in IRWIN.  

Incident_Relat 

ionship  
ReportedExpiredOnDat 

eTime  
Numeric(13,0)  1483228800000  The UTC time when the relationship 

was expired in IRWIN.  

Incident_Reso 
urce_Summar 

y  

CreatedBySystem  String(255)     ArcGIS Server username of system that 

created the IRWIN Resource record.  

IRWIN   
Feature  
Service Layer  

IRWIN Data Element  API  
Data Type  

Format/  
Example Value  

Short Description  

Incident_Reso 
urce_Summar 

y  

CreatedOnDateTime  Numeric(13,0)  1483228800000  Date/time that the IRWIN Resource 

record was created.  

Incident_Reso 
urce_Summar 

y  

IrwinID  GUID  {3A74AD5CE18C-
4B239DA0- 
B5EEFF6CDACF}  

IrwinID of the Incident to which the 

resource summary record is linked.  

Incident_Reso 
urce_Summar 

y  

ResourceAgency  String(7)  BLM, USFS, BIA  A general classification of the agency 

providing fire resources to an incident - 

top level hierarchy of resources.  
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Incident_Reso 
urce_Summar 

y  

ResourceCategory  String(25)  Kind = Aircraft,  
Cat = Airtanker,  
Fixed Wing, etc…  

An intermediate classification of 

operational resources available to 

respond to a fire - a further breakdown 

of kind.  

Incident_Reso 
urce_Summar 

y  

ResourceKind  String(10)  Aircraft, Crews,  
Equipment,  
Overhead  

A general classification of operational 

resources available to respond to a fire.  

Incident_Reso 
urce_Summar 

y  

ResourcePersonnelQua 

ntity (ResourceStatus = 

"Daily")  

Integer     The total number of personnel assigned 

to the fire resource being reported (by 

agency, provider, kind, category, and 

type).  

Incident_Reso 
urce_Summar 

y  

ResourceProvider  String(6)  SSUUUU  The NWCG Unit Identifier data standard 

to identify the agency that is providing 

the resource.  

Incident_Reso 
urce_Summar 

y  

ResourceQuantity 
(ResourceStatus =  
"Daily")  

Integer     The total number of fire resources (by 

agency, provider, kind, category, and 

type) currently being utilized by the 

incident.  

Incident_Reso 
urce_Summar 

y  

ResourceQuantity 
(ResourceStatus =  
"Initial Response")  

Integer     The total number of fire resources (by 

agency, provider, kind, category, and 

type) used during initial response.   

Incident_Reso 
urce_Summar 

y  

ResourceQuantityCurre 

ntAsOf  
Numeric(13,0)  1483228800000  The date and time that reflects the 

period for which the resource counts 

are current.  

Incident_Reso 
urce_Summar 

y  

ResourceStatus  String(16)     Indicates if the resource record being 

submitted or updated is an initial 

response resource or daily resource 

record.  

Incident_Reso 
urce_Summar 

y  

ResourceType  String(60)  Kind = Aircraft,  
Cat = Airtanker,  
Type = Heavy  
(Type 1), etc…  

The most specific classification of 

operational resources available to 

respond to a fire.  
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